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ВВЕДЕНИЕ
В настоящее время цифровые компоненты проникают во все области радиотехники, вытесняя аналоговые цепи даже в трактах сверхвысоких частот. Например, при создании фильтра можно получить цифровой фильтр с теми же характеристиками, что и у аналогового фильтра. Хотя цифровой фильтр будет состоять из нескольких тысяч активных элементов и требовать питания постоянным током, благодаря своим размерам, весу и многим другим качествам становится более предпочтительным для практического применения. 

С появлением программируемых цифровых сигнальных процессоров (ЦСП) изменилась также ситуация в проектировании и создании систем, поскольку аналоговые устройства становятся цифровыми программиру-емыми микросхемами, методы анализа переходят в методы анализа цифровых потоков данных. В результате этого задача проектирования телекоммуникационного оборудования сводится к построению матема-тической модели системы с последующей реализацией этой модели на аппаратной платформе. Такой подход требует наличия мощного инстру-ментария для разработки и тестирования математического обеспечения.

Программа Ptolemy является частью наиболее популярного сегодня программного комплекса Advanced Design System (ADS). Современное проектирование всё больше и больше нуждается в применении алгоритмов цифровой обработки сигналов как для моделирования конкретных микросхем, так и для анализа специфических характеристик радиосистем, объединяющих статические и детерминированные параметры радиотех-нических систем. Программа Ptolеmy предназначена для анализа цифровых схем и алгоритмов, а также для анализа аналоговых частей с применением алгоритмов цифрового моделирования. 

В основе любой программы моделирования обычно лежит некоторая форма представления данных, опираясь на которую разработчики могут использовать готовые алгоритмы или создавать новые. В программе Ptolomy основным инструментом анализа служит синхронизированный поток данных, передаваемый между блоками модели. 

Программа Ptolemy обладает интуитивно понятным интерфейсом для добавления и совместного использования собственных моделей пользователя и позволяет отображать данные с широкими возможностями последующей обработки. Эта программа была первоначально разработана в университете штата Калифорния (г. Беркли). Ptolemy является третьим поколением программной среды, история которой началась с января 1990 г. Программа Ptolemy унаследовала среду проектирования двух предыдущих поколений (Blosim и Gabriel), которая предназначается для цифровой обработки сигналов. В новую версию программы было добавлено большое число поведенческих моделей во временной области, которые важны для разработчиков систем связи. Среди прочего добавлены модели антенн и распространения радиоволн. Для разработчиков цифровых сигнальных процессоров был обновлен анализ данных с фиксированной точкой с возможностью масштабирования до 256 бит. В программе Ptolemy различные специализированные проектные среды обозначаются термином «домен» (область частот, область времени и область кодов). При моделировании цифровых узлов часто используется понятие синхронного потока данных (SDF, Synchronous Dataflow). Классический синхронный поток данных – это способ организации вычислений, при котором моменты появления новых данных на входах компонент точно определены на этапе компиляции. Вместо термина «синхронный поток данных» в литературе иногда используются понятия управляемый данными домен (data driven) и статически планируемый (statically scheduled) домен. Термин «управляемый данными» означает, что какая-либо из компонент схемы может быть активирована только после появления данных на её входах. Термин «статический» указывает на тот факт, что порядок возбуждения определяется один раз в начале моделирования. Синхронизированный поток данных – одно из важнейших свойств программы Ptolemy. Это означает, что расчет выполняется в области цифрового представления, а не в области непрерывных значений напряжений и токов. При разработке новых версий Ptolemy специалисты Hewlett Packard непрерывно улучшают алгоритмы обработки синхронных потоков данных. 

Далее в качестве примера рассмотрим поэтапный пример модели-рования интегрирующей цепи в программе Ptolemy.
1. Построение интегрирующей цепи 
1.1. Запуск программной среды Advanced Design System
Для обучения основным принципам работы с программой Ptolemy используем простой пример интегрирующей цепи из набора примеров программной среды Advanced Design System. В интегрирующей цепи используется делитель, сумматор и линия задержки. Для моделирования необходимо будет добавить источник сигнала, элемент представления результатов моделирования и контроллер. 
Чтобы начать работу с программой Agilent Advanced Design System (ADS), в операционной системе Microsoft Windows® нажмите кнопку Пуск, в появившемся меню выберите пункт «Программы», а затем выберите группу программ соответствующей версии программы Advanced Design System. В появившемся списке выберите пункт Advanced Design System (рис. 1).
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Рис. 1. Последовательность выбора пункта Advanced Design System
После выбора пункта Advanced Design System появится главное окно среды моделирования, показанное на рисунке 2.
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Рис. 2. Главное окно программы Agilent Advanced Design System
1.2. Копирование и открытие примера проекта

1. Скопируем проект примера. Для этого в главном меню ADS выберите File → Copy Project (Файл → Копировать проект). Отобра-зится следующее диалоговое окно:
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Рис. 3. Окно выбора места размещения проекта

2. Нажмите кнопку Examples Directory (Папка примеров), а затем кнопку Browse (Обзор). В появившемся диалоговом окне File Browser (Обозреватель файлов) на рисунке 4 содержится список папок с примерами проектов.
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Рис. 4. Диалоговое окно выбора папки с примером проекта
3. Прокрутите список папок вниз, а затем перейдите в папку /Tutorial и после выбора папки integrator_prj нажмите кнопку Choose (Выбрать).

4. Далее нажмите кнопку Startup Directory (Папка загрузки), или Working Directory (Рабочая папка), или нажмите кнопку Browse (Обзор), если необходимо выбрать другую папку.

5. Установите флажок Copy Project Hierarchy (Копировать иерархию проекта). Это гарантирует, что будут скопированы все необхо-димые каталоги и файлы. В учебных целях флажок Open Project After Copy (Открыть проект после копирования) должен быть снят.
6. Нажмите кнопку OK, чтобы скопировать проект и закрыть текущее диалоговое окно. 

7. В папке проекта integrator_prj щелкните правой кнопкой мыши по вложенной папке Networks (Цепи), чтобы открыть схемы в рамках этого проекта, которые будут иметь расширение DSN.

8. Дважды щелкните курсором мыши по файлу integrator1.dsn.         В области Design Information (Сведения о макете) справа дважды щелкните курсором мыши по схеме integrator1. Это приведет к открытию окна со следующей схемой:
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Рис. 5. Структурная схема интегратора
1.3. Выбор и размещение элементов схемы
1. В дальнейшем потребуется добавить источник синусоидального сигнала, элемент представления результатов моделирования и контроллер для интегрирующей схемы. Существуют два способа выбора элементов библиотеки:
а) Из палитры. С левой стороны окна на рисунке 5 расположена палитра, содержащая значки для определенных элементов. Элементы размещаются путем их выбора в палитре и последующим переносом на макет схемы.

б) Из библиотеки. Элементы схемы можно также разместить путем выбора меню Insert → Component → Component Library (Вста-вить →Компонент → Библиотека компонентов). Отобразится диало-говое окно, которое содержит библиотеки элементов. Выберите необхо-димый элемент.
2. Добавим источник сигнала. Для этого используйте первый способ – палитру, расположенную с левой стороны окна. Необходимый нам элемент размещается в библиотеке Common Components (Общие компоненты). Щелкните курсором мыши по значку SinGen. Отобразятся пересека-ющиеся линии и контурное изображение элемента, которые можно перемещать в пределах окна макета. Переместите перекрещенные линии слева от элемента Fork2, а затем однократно щелкните курсором мыши по его входу. Схематическое представление элемента источника синусои-дального сигнала будет размещено на макете схемы. Под элементом сину-соидального сигнала размещаются его название и редактируемые пара-метры. Будем использовать название и значения параметров по умол-чанию.

3. Чтобы завершить размещение компонентов, нажмите кнопку End Command (Завершить команду) на панели инструментов или Escape (Отменить) на клавиатуре компьютера. После этого перекрещенные линии исчезнут. Если необходимо продолжить размещение компонентов (как в этом примере), то этот этап можно пропустить. Если выбор элемен-тов не отменен, то при каждом щелчке левой кнопкой мыши будет разме-щаться новый выбранный элемент из палитры. 

4. Добавим элемент представления результатов. В этот раз исполь-зуем метод выбора элементов с помощью соответствующей библиотеки элементов. Выберите пункт меню Insert → Component → Component Library (Вставить → Компонент → Библиотека компонентов). Отобразится диалоговое окно, которое содержит библиотеки элементов. Из списка Libraries (Библиотеки) выберите Interactive Controls and Displays (Интерактивные элементы управления и отображения).
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Рис. 6. Окно библиотек элементов
5. В области Components (Компоненты) выберите элемент TkPlot. Отобразятся пересекающиеся линии и контурное изображение выбранного элемента, которые можно перемещать в пределах окна макета схемы. Другой элемент TkPlot уже расположен на схеме для отображения входного сигнала. 
6. Разместите элемент TkPlot, как показано на рисунке 7.
[image: image8.png]DynarmicL ik DesignGuide  Help

5 8, &

Simulate  Window.

Ele Edit Selct View Insert Options

ER=AS lm!

Common Components
8

ook Layout

Ik

o i

Paette

SineGen g
st
RadiansPerSample=pi/50
InitialRadians=
y
0100
1515
onnect

2750,0625 | -4875,3375 | i DSP SimSchem

wire

<
starting point

Select: Enter the




Рис. 7. Окно макета схемы интегрирующей цепи с источником сигнала SineGen и элементом TkPlot для отображения результатов моделирования
7. Нажмите кнопку со стрелкой End Command (Завершить команду) на панели инструментов или Escape (Отменить) на клавиатуре. После этого перекрещенные линии исчезнут. Нажмите кнопку OK, чтобы закрыть диалоговое окно Component Library (Библиотека компонентов).
1.4. Изменение параметров элементов макета схемы
1. Изменим два параметра для элемента TkPlot. Существует нес-колько способов для редактирования параметров элементов, среди которых:

· двойной щелчок курсором мыши по элементу;
· выбор пункта меню Edit → Component → Edit Component Parameters (Редактировать → Компонент → Редактировать параметры компонента);
· нажатие кнопки Edit Component Parameters (Редактировать параметры компонента) [image: image9.png]


 на панели инструментов;
· ввод нового значения параметра непосредственно на странице схемы. 
2. Дважды щелкните курсором мыши по элементу TkPlot. Отобра-зится следующее диалоговое окно.
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Рис. 8. Окно изменения параметров элемента TkPlot
3. Выберите параметр xRange и измените его значение 100 на 400. Затем выберите параметр yRange и измените его значение -1.5 1.5 на 0 32. Аналогичным образом выберите параметр Persistence и измените его значение 100 на 300. В поле Label (Метка) для параметра с одноименным названием введите Output для того, чтобы можно было отслеживать графики входного и выходного сигналов.

4. Нажмите кнопку OK, чтобы закрыть текущее диалоговое окно. 
1.5. Добавление контроллера

Контроллеры используются для задания типа моделирования и его параметров.

1. В палитре Common Components выберите значок Data Flow Controller (Контроллер потока данных) [image: image11.png]


. Отобразятся пересе-кающиеся линии и контурное изображение контроллера, которые можно перемещать в пределах окна макета схемы. 

2. Однократно щелкните курсором мыши на участке макета схемы, где необходимо разместить контроллер. Схематическое представление контроллера размещается в окне макета схемы. Контроллер не подключен к другим элементам и не соединен с ними проводниками. Будем использовать для контроллера его значения по умолчанию.

3. Нажмите кнопку со стрелкой End Command (Завершить кома-нду) на панели инструментов или Escape (Отменить) на клавиатуре. После этого перекрещенные линии исчезнут.
Примечание. Существует несколько типов контроллеров. Выбран-ный контроллер называется Data Flow controller (Контроллер потока данных) и используется для выполнения моделирования обработки смешанных цифровых и аналоговых сигналов.

На данном этапе моделирования интегрирующей цепи макет схемы должен выглядеть следующим образом:
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Рис. 9. Окончательный вид макета схемы интегрирующей цепи, подготовленный для моделирования

На этом сборка макета схемы интегрирующей цепи завершена и можно перейти непосредственно к моделированию ее свойств.
2. Моделирование интегрирующей цепи
Программная среда Advanced Design System обладает широкими возможностями для выполнения моделирования. В нашем примере используется элемент интерактивного представления, называемый TkPlot. Этот элемент выполняет быстрое отображение результатов модели-рования. В дальнейшем на макет схемы будет добавлен элемент Sink, который позволит сохранять результаты моделирования в файл. Элемент Data Display будет использоваться для сравнения и проверки полученных результатов.
2.1. Запуск моделирования и отображение его результатов
1. Выберите пункт меню Simulate → Simulate (Моделировать → Моделировать). Начнется процесс моделирования. Отобразится окно состояния, которое содержит сведения о процессе моделирования или об имеющихся ошибках.

2. Два появившихся окна TkPlot отображают анимированное пред-ставление входного синусоидального сигнала и результатов модели-рования (рис. 10).
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а)                                                                           б)
Рис. 10. Форма входного (а) и выходного (б) сигналов
В данном примере синусоида источника сигнала изменена на коси-нусоиду (сдвиг на 90º) путем применения интегрирующей цепи. Моде-лирование должно быть остановлено вручную. После просмотра аними-рованных графиков выберите Quit (Выход) в небольшом диалоговом окне с заголовком Agilent Ptolemy.
2.2 Альтернативный способ отображения результатов
      моделирования
Теперь используем альтернативный способ отображения результатов моделирования, для которого на схеме будет использоваться элемент Sink.

1. Щелкните курсором мыши по элементу TkPlot на макете схемы, чтобы выбрать его.

2. Нажмите кнопку Delete (Удалить) [image: image15.png]


 на панели инструментов.

3. В палитре Common Components выберите значок Numeric (NumericSink). На макете схемы отобразятся пересекающиеся линии.

4. Поместите элемент NumericSink вместо ранее имевшегося на схеме элемента TkPlot.

5. Дважды щелкните курсором мыши по элементу NumericSink, чтобы отредактировать его параметры.

6. Оставьте неизменным значение по умолчанию DefaultNumericStart для параметра Start, а для параметра Stop задайте значение, равное 200. 
7. Нажмите кнопку OK.
8. Выберите пункт меню Simulate → Simulation Setup (Модели-ровать → Настройка моделирования). Отобразится диалоговое окно Simulation Setup (Настройка моделирования) (рис. 11). Этот этап можно пропустить, если нет необходимости в указании названия для набора данных.
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Рис. 11. Диалоговое окно Simulation Setup
9. В поле Dataset (Набор данных) введите название myresults. Это позволит задать имя файла с результатами моделирования. Оставьте неизменными значения по умолчанию для других параметров.

10. Нажмите кнопку Simulate (Моделировать), расположенную вни-зу окна. Начнется процесс моделирования. Отобразится окно состояния, которое содержит сведения о процессе моделировании или об имеющихся ошибках. В это время данные сохраняются на диск, что позволяет использовать их при отображении результатов моделирования в различных форматах или для использования в процедурах последующей обработки. Кроме того, входной элемент TkPlot отображает анимированный график для входного сигнала.
11. Нажмите кнопку Quit (Выход) в диалоговом окне Agilent Ptolemy, чтобы закрыть окно.

12. Выберите пункт меню Window → New Data Display (Окно → Отобразить новые данные). Откроется окно Data Display (Отображение данных).

13. Из выпадающего списка с левой стороны окна выберите пункт myresults. Этот список называется Default Dataset (Набор данных по умолчанию).
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Рис. 12. Окно Data Display
14. Щелкните курсором мыши по элементу Rectangular Plot (График в декартовой системе координат) в палитре Plot Types (Типы графиков) с левой стороны окна. Отобразится эскиз прямоугольной рамки.

15. Однократно щелкните курсором мыши для того, чтобы раз-местить рамку в окне Data Display (Отображение данных). Отобразится диалоговое окно на рисунке 13.
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Рис. 13. Окно настройки параметров графика 
отображения результатов моделирования
16. Выберите в списке элемент N1, а затем нажмите кнопку Add (Добавить), чтобы выбрать данные, которые необходимо отобразить. 
17. Нажмите кнопку OK. 
Выбранные результаты моделирования будут представлены в окне Data Display (Отображение данных) так, как показано на рисунке 14.
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Рис. 14. Окно Data Display с временной зависимостью формы 
выходного сигнала интегрирующей цепи

Для изменения размера графика можно использовать различного рода кнопки изменения масштаба, расположенные на панели инстру-ментов, или перетащить нижний правый угол окна. В данном окне может быть выполнено большое число задач по представлению данных в графи-ческом виде с последующей обработкой. 

Рассмотренные способы отображения данных начинаются с разме-щения элемента отображения данных на макете схемы и обладают следую-щими различиями:
· использование элемента TkPlot (один из нескольких интер-активных элементов отображения данных) не позволяет сохранять на жесткий диск компьютера результаты отображения данных моделирования;
· окно Data Display (Отображение данных) позволяет сохранять данные и использовать их для представления в различных форматах.
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